
Tutorial

Music promos are designed to grab your attention, capture the imagination and 

keep you entertained with each and every frame. Sequence Post-Production 

shows you how to create a dramatic and energetic piece of video work… 

[illustration] CHU, www.schudio.co.uk
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O
ver the following pages we demonstrate the various editing techniques 
used in music promo cutting. From pacing your edit to advanced effects 
and colour correction, we explore a range of techniques to help you 
really capture your audience. 

The featured example is the debut video for Oxford-based rock band King 
Furnace (www.kingfurnace.co.uk). The brief for the fi lm was essentially to make it 
good and make it cheap, which is an all-too-familiar starting block. 

With a limited budget and an extremely quick turnaround before the release of 
the single, Crash, earlier this year, at Sequence Post-Production it was essential that 
we chose the most cost-effective formats throughout the production process.  Most 
commonly, music videos are shot using fi lm and are then telecined for digital post-
production. This was out of question for King Furnace and, like many other low-
budget productions, we chose to use good old DV-Cam. It’s not unusual for this 
low-budget format to crop up on mid-range music video productions because more 
producers are realising the benefi ts and the potential of the cheaper format when it’s 
in the right ‘professional’ hands. 

The digital platform also makes more sense when considering the ever-changing 
delivery formats available. As iPods, video mobiles, broadband and digital TV are 

becoming more and more popular, producers are having to adapt by creating 
content for a multi-platform market place.

The King Furnace shoot took place in a simple blacked out rehearsal room using 
a variety of video lights, Sony DV-Cam cameras and standard DV-Cam tape stock. 
The images produced for our edit far exceeded our initial expectations.

We decided to take on all post-production at the Sequence studio using our 
Final Cut Pro online suite, which proved to be the most cost effective and, in fact, 
a far more ‘editor friendly’ option. Apple’s Final Cut Pro platform is currently going 
stellar, with production companies around the world moving over to the system 
thanks to its intuitive interface, multi-format capabilities and, most importantly, 
its value for money. The beauty of the software is its fl exibility and huge variety of 
functions, allowing you not only to cut, but also perform high-quality grading, 
compositing and titles without leaving the main software package.

The following tutorial will highlight six stages of the post-production process 
which took place during the making of Crash. An overview of the workfl ow we 
employed will hopefully give you a good insight into the world of music video post-
production and inspire more wallet-friendly music videos to creep their way into the 
ever-growing galaxy of podcasts, downloads and ‘red-button’ TV channels.

51Tutorial Making a music video

Expertise provided by Ben Foakes and Katharine Cartmell. Featured video: Crash by 
King Furnace, Producer/Director: Katharine Cartmell, Editor and Effects Artist: Ben 
Foakes. For further information about Sequence Post-Production or advice on your own 
music video production visit www.sequence-post.co.uk or contact Ben Foakes at 
info@sequence-post.co.uk  

You’ll fi nd the fi nished King Furnace music video 
on the Computer Arts Projects CD88.
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3
A good 
relationship 

between editor 
and director helps 
to give the video 
a natural energy. 
Crash is full of fast 
cuts, crazy lighting 
and vibrant 
performance, 
which was very 
much enhanced 
by the freedom 
allowed in the 
cutting process.

5
When you’re selecting and assembling your rough cut, the key to maintaining 
energy and keeping your audience’s attention is movement. Whether it’s a 

camera move, a dance move or a special-effects shot, you must keep the sense of 
motion alive throughout the piece. Watch MTV and notice the lack of long, static 
compositions during music videos. You’re bringing the music to life visually, and, 
without movement, the viewer may as well listen to the CD.

There are infi nite 
ways to approach 
the production of a 
music video. You 
could use a single 
shot throughout and 
clever time-ramp 
trickery on camera; 
your video could tell 
a touching story 
using cinematic 
imagery and limited 
effects; or you could 
simply capture raw, 
unadulterated 
performance. The 
music video is one 
of the few media 
products where art 
and video work in 
perfect harmony. 

No rules

4
When viewing, logging and capturing the material, don’t 
write off anything. In music videos you can use ludicrous 

shots, movements and elements captured on tape that would 
normally be trashed before the edit even begins. 

King Furnace is a 
great live act – 
loads of energy with 
tons of spontaneity 
and humour in its 
shows – so this 
needed to be 
translated into the 
video. It was hugely 
important to 
capture that high-
energy performance 
and as much of the 
spontaneity as 
possible, and this 
dictated the way we 
went about planning 
storyboards, fi lming 
and editing rushes, 
as, of course, it was 
largely down to what 
the band did on the 
day of the shoot.

High energy

Tutorial Making a music video

Part 1: Workfl ow 
Music videos borrow styles from all genres of fi lm production…

1
Music videos 
can be 

approached from 
a variety of angles. 
A video that is 
scripted with a 
strong sense of 
narrative will be 
heavily planned 
and storyboarded 
before the shoot, 
allowing the editor 
only limited 
fl exibility at the 
cutting stage. At 
the opposite end 
of the scale, a 
video shot with a 
raw, live feel, may 
really lend itself to 
improvisational 
editing methods.

2
The key to music video editing is freedom and 
maintaining natural energy. For the Crash video here we 

approached the edit with a very open mind. There was a 
basically planned structure for the piece, but we essentially 
allowed the rushes to drive our editorial decisions, stitching the 
shots together where they worked best to the music. 

6
Don’t expect to knock out a music video in a few hours – the King Furnace 
Crash video was squeezed into a 48-hour block of intense studio time. Unlike 

many other television formats, music videos often contain hundreds of different 
shots within just a few minutes. Be prepared to spend long, labour-intensive hours 
on your cut from rough assembly to fi ne-tuning. You will defi nitely reap the rewards.
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Part 2: The cut
Let the music and the visuals become one in Final Cut Pro…  

2
A good fi rst step in the rough edit stage is to play through your track and mark 
key points on the fl y. Drag your audio fi le into the sequence and position it on 

tracks A3 and A4 (freeing up A1 and A2 for your rushes guide audio). Play the track 
all the way through, listening carefully to all the beats and punctuations. Use the 
marker button (the shortcut is ‘) to lay markers onto your timeline at each point you 
feel may work well as a cut or picture punctuation. Next, check the lip syncing. 

3
Use the live 
audio from 

your rushes to sync 
precise accents in 
the music with the 
CD track on the 
timeline. Use strong 
letters like ‘t’ and ‘s’ 
or loud symbol 
crashes as sync 
points. By pressing 
Opt+ Cmnd+W 
(Mac) or Alt+Ctrl+W 
(PC) you can load 
waveforms on the 
Final Cut Pro 
timeline. Use the 
marker tool to 
pinpoint frames on a 
clip or your timeline 
to help you line 
elements together.

4
It’s often easier to lay down several shots and lock the sync 
points before you start to craft your sequence, but fi nding 

the perfect sync points can be time consuming. When editing a 
section using two or more shots, inter-cut together, it makes 
sense to sync the fi rst frames before you make any edits in the 
tracks. Lay each different shot layer onto the timeline, one 
above another, using the recorded guide audio from the rushes 
to fi nd a common sync point. You can now cut between the 
layers without losing track sync. Action in the lower layers can 
be viewed by turning off the monitor button (green circle on far 
left of timeline) corresponding to the track you wish to conceal.

5
Final Cut Pro offers a range of useful tools for quick and 
easy fi ne-tuning. When fi nalising your music video cut, 

try using trim mode to fi ne-tune edit points. By double-clicking 
on a cut point, FCP loads the trim window, allowing you to 
view incoming and outgoing material as you adjust the cut 
position. This is very useful when an editor needs to get a 
frame-perfect result. Another quick way of performing trims is 
to use the Roll-edit tool (r).

6
It’s good practice to up-convert your sequence resolution 
before you start colour grading or effects work. Go to the 

Audio Video Settings in the Final Cut Pro dropdown menu and 
change Sequence Settings to ‘Uncompressed PAL 10 bit’. In 
your open project, select a New Sequence from the File 
dropdown menu. Select all (in your original edit) and copy and 
paste it into the new uncompressed timeline. Each clip will 
require re-rendering but this is not necessary at this stage.

1
There are so many ways of marrying pictures to sound but often the most effective are those 
moments when natural, organic movement within a frame falls upon an appropriate punctuation in 

the sound track. In this example, the cameraman follows the lead singer and drummer in a three-point 
camera move, while the performances match their own energetic movement with the music.  

When making a 
music video, you’ve 
got to know the song 
backwards. In a 
performance-based 
video, as opposed 
to a story-based 
video, you should 
not be ruled by the 
storyboard. Your job 
is to make the band 
look good, taking 
the most visually 
arresting parts of 
the performance 
and enhancing the 
music as well as 
you can. Being 
fl exible and feeling 
your way around the 
edit is a must.

Know the song
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As this was King 
Furnace’s fi rst video, 
the dark set with 
moving lights was a 
bonus thematically 
- we were lifting the 
lid on this band and 
exposing them to 
the public. This then 
grew into a wider 
theme – that the 
band and their 
music were 
contagious and 
infectious, like a 
virus. So we 
storyboarded shots 
of a scientist 
studying the band 
under a microscope.

Themes

Tutorial Making a music video

Part 3: Grading and colour
Colour treatment can completely alter the mood and impact of the piece…

1
This video was intentionally fi lmed for a black-and-white 
colour grade. Producer/Director Katharine Cartmell 

wanted the fi lm to have a variety of black-and-white looks for 
different scenes. The scientifi c shots have been graded to look 
extreme and almost Pop Art-like, with lots of white light, 
whereas artist performance shots have been treated to add 
softness and glamorous attributes to the band members.  

2
Final Cut Pro’s 3-Way Colour 
Corrector has to be the quintessential 

fi lter for any budding grading artist. It 
allows you to adjust the blacks, mid-
tones and highlights of an image 
independently as well as the full spectrum 
of chrominance and saturation values. Use 
it to crush the blacks, boost the mid-tones 
and reduce pigment to achieve your 
desired black-and-white look.

3
Next, use the de-interlace fi lter in FCP to add to the fi lmic 
look of the piece. By de-interlacing a standard video clip, 

you are effectively removing a fi eld of picture information. If 
you remove an odd or even fi eld, the video image appears to 
play like a progressive fi lm clip. This technique is commonly 
used in music videos and promos to take the edge off ultra-
clear video and give it a more organic appearance. Use the 
Flicker Filter Max option to blend the fi elds together, 
smoothing the image with a silk-like effect. 

1
It’s worthwhile ensuring that the elements you wish to 
composite together have already been treated for colour 

grade and basic fi nish. This will aid the process of compositing 
and enable you to see more clearly how the fi nal product will 
look. When using more advanced packages such as Shake, it’s 
more likely that the video artist will work with original rushes, 
manipulating far more parameters simultaneously within the 
same working composition.  

2
You can use Photoshop to create basic black-and-white 
mattes, which can then be imported into FCP as keying 

layers. In this example, the top layer shot of the singer has 
been exported from FCP as a PSD fi le and then drawn over in 
Photoshop to create a customised matte shape. Make sure 
that the white section of your PSD represents the area of the 
original image that you wish to keep, and the black represents 
the area you wish to be key out.

3
Import the 
PSD into FCP 

and sandwich it as 
a layer in-between 
your two plate 
shots. The 
background should 
be at the bottom 
and the foreground 
on the top. Go 
to the Modify 
dropdown menu, 
select Composite 
Mode and then 
choose ‘Travel 
Matte – Luma’. This basic selection will use your middle layer 
and key out the unwanted areas of the top shot. A Luma Key 
uses luminance values to mask out shot-specifi c elements.

4
Light fl ares are often used in music videos to accentuate 
the sense of motion and energy. Like all grading fi lters, a 

poorly or overused effect can ruin a shot. Colour glow is one 
such example where pushing it too far can burn out valuable 
picture elements. Always adjust the tolerance and softness 
levels to ensure a smooth and natural fi nish. The colour glow 
plug-in used here is available from www.cgm-online.com.

5
Always take 
care to ensure 

that an effect that 
looks good on one 
section of a shot 
does not ruin 
another. For 
example, if you 
boost the mid-
tones on the 
face, does the 
background 
become too burnt 
out? You can use 
garbage mattes on 
multiple layers of the same shot to mask out individual sections 
of a video clip and grade each according to its own image 
values. Start by copying the original layer and making a stack 
of the same shot.

6
Go to the Effects tab and select the Matte folder. Drag 
the Eight-Point Garbage Matte onto the upper layer of 

your composition. Adjust the matte point positions one at a 
time to section off the desired area of picture. Perform the 
required grade for that segment. Now use edge, smooth and 
feather in the Garbage Matte controls panel to blend the 
layers together, giving a seamless fi nished composition.

Part 4: Compositing in Final Cut Pro
Final Cut Pro works seamlessly with Photoshop, aiding effects workfl ow…
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2
Make sure your screen layout 
allows you good access to the 

keyframe controls. Like a lot of software, 
some of the control panels and buttons 
in FCP can be fi ddly. When creating 
keyframe effects, it’s advisable to adjust 
and save a new window layout. Try 
re-arranging the windows so that your 
viewer window is most dominant on the 
screen. Also ensure that the canvas is a 
good size, in order that you can view a 
clear preview of the adjustments you’re 
about to make.

3
Next, use keyframes to animate fi lter behaviour and create dynamic light 
effects. Double-click your working shot to load it into the viewer window. 

Select the Filters tab and make sure that the keyframe timeline is clearly visible. 
Create a keyframe by simply clicking the diamond-shape symbol next to the value 
panel for any active parameter. Move your playhead through the clip and adjust 
values at different moments in the shot. Once you’ve made the fi rst keyframe, any 
more adjustments you make after that will be automatically recognised and a 
keyframe will be added.

4
Even the most basic of comps will require minor motion 
and perspective alterations. Here, we’ve used the Motion 

tab and the Image + Wireframe selector to control the position 
and perspective of the upper layer. By reducing the scale, 
cropping the unwanted edges and partially distorting the 
aspect of the layer, the singer appears to blend in better with 
the background. You can use the Image + Wireframe tool to 
visually drag scale, rotation and position in the Canvas window.

5
Every key effect requires additional tweaking to get a 
clean composition. A useful tip for tidying up a Luma Key 

is to add a blur fi lter effect to your PSD layer. In this example, 
we’ve added Gaussian Blur at a level of 10 per cent. This 
effectively smoothes the transition between the lights and 
darks of the matte and has the knock-on effect of improving 
the blend between your background and foreground layers.

6
Once the two layers have been composited together, it’s 
time to colour match the elements to improve realism. In 

most cases, two separate shots will have inherently different 
colour and luminance values. Use your Filters tab to adjust each 
colour fi lter independently for each layer. The built-in video-
scopes in FCP can help you to accurately match RGB and 
Luminance values between shots (see Tools>Videoscopes).

1
Keyframing is one of the staple elements of all effects work. It’s a technique 
used to animate clip parameters manually, creating controlled changes 

throughout a clip. In this example, keyframing was used to animate a colour glow 
fi lter and create a strobing/disco light effect in time to the beat of the music.

Compositing in Final Cut Pro continued...

Part 5: Keyframe effects
Keyframing allows you to control each and every parameter of a video image…
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6
When the colour grading, compositing and keyframing is 
complete, the entire edit sequence will require rendering 

for full resolution playback. If the sequence was set to 
‘Uncompressed PAL 10 bit’, when FCP generates the newly 
rendered media fi les, the edit will be fi nished in its best 
possible quality. If you forgot to paste your edit into an 
uncompressed timeline, don’t worry – the up-conversion can 
be done at any stage before the fi nal render.

57Tutorial Making a music video

4
For this scene in the video, the director wanted the effect 
of disco lights inside the microscope to fl ash in time with 

the beats of the music. Start by clicking on your working clip in 
the timeline to highlight it. Now scan through and add markers 
directly onto that layer at the desired beat points. When you 
view your keyframe timeline in the viewer, you’ll also see the 
marker points along the top of the window. Simply align your 
keyframe points with the markers to achieve effects that sync 
with the music track. 

5
In a similar way to the 
previous demonstration, a 

PSD matte was used here to 
contain a specifi c area of the shot. The keyframed light fl are 
effect is unavoidably applied to the entire base layer of this 
composition, so to contain it to just affect the microscope light 
tube, it was essential that we used a matte. Following the 
same Luma Key rules, we carefully erased the areas of picture 
around the light holes to get this clean fi nished effect.

4
Exporting for web content is easy with FCP’s Compressor 
application. Mark an ‘in’ and ‘out’ point at the fi rst and 

last frames of your edit. Go to the File dropdown menu and 
select Export>Using Compressor. The software application 
Compressor will load and open up your edit sequence as a 
source fi le in the main window. There are many compression 
settings to choose from. For example, select ‘Web download – 
QuickTime 7 compatible’ and choose from a variety of Apple 
settings. Set a destination folder and click Submit. Apple’s new 
H.264 codec far surpasses anything we’ve used before for web 
video and is a great option for showcasing your work online.

5
You can podcast your fi nished music video for the world 
to see. Mark up your edit with an ‘in’ and ‘out’ point and 

once again go to the Export menu. This time select Export> 
Using QuickTime Conversion. Now click on the Format tab and 
change the QuickTime setting to iPod (320x240). Give your fi le 
an appropriate name and save it to a destination folder. The 
preset MPEG 4 fi le looks amazingly clear when transferred to a 
video iPod via itunes. Use this system to demonstrate work to 
potential clients and you should get great feedback.

1
Always view your fi nal edit in a darkened room with a 
high-quality monitor and speakers. If you’re on a tight 

budget and don’t have a full, broadcast-ready suite, we 
recommend spending that little bit extra on a good CRT 
monitor and decent audio monitoring. It doesn’t always matter 
how fast your computer system is – it’s far more important 
that the visual and audio quality is there.

2
If you’re mastering your fi nished piece for broadcast then 
seek professional advice to make sure it’s legal. Television 

channels have strict regimes for technical checking of all 
broadcast content. Colour legalities, luminance values, epilepsy 
scans, audio peaking, bars and tone – everything will be 
analysed. If you don’t run a full online suite with the correct 
peripherals then always seek advice from a professional outfi t.

3
Final Cut Pro 
Studio is 

accompanied by 
Apple’s industry 
leading DVD Studio 
Pro software. 
Making a DVD 
master can be as 
hard or as simple as 
you wish to make it. 
If you’re a beginner, 
try exporting your 
fi nished fi lm from 
FCP using the 
MPEG 2 encoder in 
QuickTime Conversion. Import the fi les into DVD Studio Pro 
and customise a pre-made template with your own 
background image and text. Save your project and burn to 
DVD-R. For more advanced users, DVDSP offers a multitude of 
advanced features for menu design, subtitling and even 5.1 
Dolby surround sound. 

Part 6: Mastering and delivery
Make sure that your picture and sound mix is tweaked to perfection…
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BACKGROUND:
With a solid grounding in extreme sports as both an athlete and video producer, Foake’s 
early days in the media industry saw him producing specialist BMX fi lms for worldwide 
release. His love of fi lmmaking led him to study a BA (Hons) degree in Television and 
Video Production at Bournemouth University Media School. After he graduated, Foakes 
started out as an Avid Film Composer Editor for ITV Meridian and soon progressed to 
Head of Post-Production at Bournemouth-based Redballoon Productions.

In 2004, he qualifi ed as a professional Quantel and Final Cut Pro operator, turning his 
hand to software demonstration of systems. After moving to London as a freelancer, he 
edited for a range of broadcast, design and corporate clients. In early 2006, he combined 
his technical and creative skills along with a passion for business to launch Sequence 
Post-Production Ltd.

YEARS PRACTISING AS A CREATIVE: Six years professionally.

CLIENTS: SPP currently handles the post-production on a range of multimedia products 
for clients including: ITV, North One Television, Deep End Media Ltd, MIP Agency, TWA 
Design, Redballoon Productions, BHP-Sport Ltd, Chromata Design and more.  

MISSION STATEMENT: “SPP takes pride in offering the highest quality post-production 
service to broadcast, fi lm and design clients, without charging the usual high city rates.”

WEBSITE: 
www.sequence-post.co.uk 

Expert profi le: Ben Foakes
Sequence Post-Production’s Director/Senior Editor Ben Foakes specialises in video editing, grading and compositing…

Top: Director Daniel Cormack recently 

approached Sequence Post-Production 

to perform the full online digital grade 

and 5.1 Dolby DVD mastering of his 

debut short fi lm Amelia & Michael.

Far right, top to bottom: SPP’s biggest 

contract to date involves the full post-

production of high-end VT features for 

the Formula One series on ITV. 

Right: In 2005, Ben Foakes and business 

partner Jasmine O’Brien co-produced 

extreme sports documentary Legend. 
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